
 

 

 

  

AWR ANALYZER 
For ORACLE database 

SQL Metrics 
awr@sqlmetrics.com 

Abstrakt 
SQL Developer plug-in which rapidly reduce time for analysis in user friendly GUI 



 

1 

 

AWR ANALYZER 
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                                                     INTRODUCTION 

Dear Customer, 

Following pages describe the product of SQL Metrics company which was designed to 

make the work with the Oracle® database systems much easier. 

. 

 

AWR Analyzer is distributed as a plug-in for the Oracle® SQL Developer tool. 

 

It provides users with a quick SQL analysis and problems detection in attractive GUI without 

requiring an installation of any database procedures, triggers or functions. It is fully 

operational right after the installation.   

Plug-in also contains the basic SPM (SQL PLAN MANAGEMENT) functionality.  

 

Analytic tool AWR Analyzer is developed for Oracle® databases of version 11.2 or higher 

and both Standard and Enterprise editions (AWR or STATSPACK). 

 

 

Regards, 

team SQL Metrics 
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INSTALLATION REQUIREMENTS 

 

Minimum requirements for the installation of AWR Analyzer: 

• Operating system: Mac OS®, Windows® a Linux® 

• SQL Developer: version 19.2.* or higher 

 

 

 

 

Note: Plug-in doesn't provide an Oracle license for using AWR (Automatic Workload Repository). 

To use AWR functionality it is necessary to own the Oracle Diagnostic Pack license. 

You can find license fees in official Oracle price list or your Oracle distributer. 

 

 

 
 

STATSPACK service is a predecessor of the AWR. 

In solutions using Standard Edition (SE) or 12c Standard Edition (SE2) provides STACKPACK 95% of data which provides AWR and is 100% free for installation & 

use.  

 

AWR Analyzer works with both Oracle RAC and non-RAC systems from the version 11.2.  

 

For the correct functionality of the plug-in is necessary to have installed a STATSPACK or AWR package and grant User Rights for the objects.   

 

 

 

*it is possible to provide plug-in for older versions after the consultation. Minimum number of licenses is 20.  

  

https://www.oracle.com/corporate/pricing/
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INTRODUCTION 

 

 

The standard STATSPACK/AWR analyzer provided by Oracle corporation as a component of the Oracle database has to be executed as a script and only 

provides the output in the text form which is complicated to read. Also it is not possible to see SQL execution plan without creating new output. Text output is 

divided to several sections and to find the links between data user has to scroll between particular sections.  

 

Example of the standard AWR analyzer output after execution: 

For AWR:  

SQL> @$ORACLE_HOME/rdbms/admin/awrrpt.sql 

 

For STATSPACK: 

SQL>  @?/rdbms/admin/spreport 

 

    CPU                  CPU per             Elapsd                     Old 

  Time (s)   Executions  Exec (s)  %Total   Time (s)    Buffer Gets  Hash Value 

---------- ------------ ---------- ------ ---------- --------------- ---------- 

Module: DBMS_SCHEDULER 

MERGE /*+ dynamic_sampling(4) dynamic_sampling_est_cdn  */ INTO 

SYS.MON_MODS_ALL$ MM USING ( SELECT OBJ#, SUM(FLGS) FLGS FROM ( 

SELECT OBJ#, :B1 FLGS FROM ( SELECT DISTINCT TAB.OBJ# FROM (SELE 

CT T.OBJ# OBJ#, T.OBJ# BO#, T.ANALYZETIME FROM SYS.TAB$ T WHERE 

 

      9.40           72       0.13    3.5      10.94       2,992,477   62099832 

Module: DBMS_SCHEDULER 

INSERT INTO WRI$_HEATMAP_TOPN_DEP2 SELECT TABLE_NAME, OWNER, 'LO 

BS', SUM(SEGMENT_COUNT), SUM(OBJECT_SIZE) FROM DBA_LOBS, WRI$_HE 

ATMAP_TOPN_DEP1 WHERE WRI$_HEATMAP_TOPN_DEP1.OBJECT_NAME = DBA_L 

OBS.SEGMENT_NAME AND WRI$_HEATMAP_TOPN_DEP1.OBJECT_OWNER = DBA_L 

 

 

 

WHY USE AWR ANALYZER 

Analyze AWR plug-in represents data in much more user friendly GUI: 

• Tabular data output 

• Filter data by SQL Module 

• Details of the SQL query accessible on one click with possibility to open details in the new tab on double-click. 

• Display of SQL statement in formatted form 

• SQL execution plan  

• Exporting of the selected data into pdf or excel file or into clipboard 

• Possibility to define quantity of displayed data 

 

In addition it provides the data and the tools which are not components of the original AWR:  

• #Of Exec. Plans - number of the distinct execution plans used for the particular SQL statement 

• Binding Variables – logical true/false value which represents whether given SQL has stored binding variables during the run 

• SQL Plan Management - tool for maintaining the execution plans (detailed description of SPM functionality is available on the official Oracle web-page) 

  

https://oracle-base.com/articles/11g/sql-plan-management-11gr1
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ACCESS TO AWR ANALYZER 

 

Access to AWR Analyzer plug-in is located in SQL Developer "View" menu under ”AWR and STATSPACK Monitoring Tools“ menu item 
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USERS PREFERENCES 

 

Plug-in allows user to make his own individual setting: 

• Colors and the number of displayed rows  

• Language version 

 

 

PANEL NASTAVENÍ 

 

To open the preferences panel click on „Tools“ -> “Preferences“ 

 

 

 

In Preferences panel you can adjust: 

• Number of displayed rows for statistics tables  

• Table odd rows color 

• Table even rows color 

• Table percentage bar color 
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LANGUAGE VERSIONS 

 

Language selection is managed by SQL Developer itself.  

On the Internet there are several manuals how to change the language in SQL Developer. For example on this link. 

 

The plug-in is originally delivered in two language mutations: 

• English 

• Spanish 

Some other language mutations may be added in the future. Or can be added on demand after previous agreement. 

  

http://sql.standout-dev.com/2018/04/howto-change-sql-developer-language/
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ANALYZE STATSPACK / ANALYZE AWR 

 

(Panels are almost identical. Differences are mentioned in separate section.) 

Access to both tools is from the menu "AWR and STATSPACK Monitoring Tools" and: 

“Analyze STATSPACK” 

or 

“Analyze AWR” 

 

 

Panel “Statspack Snapshots“ is opened with basic criteria for selection of: 

• time interval for the monitored SQL events (it is possible to select more consecutive intervals)  

• database server 

• database  

• “node” in the selected database.  

 

Selection criteria allow selecting from more databases and nodes. This is possible when there are some imported STATPACKs from other databases. For example 

from production database which can be physically located on different place or if user from any reason just doesn’t have an access to it. 

AWR Analyzer plug-in allows to work with imported data from external sources. 

 

 
 

 

TIME INTERVAL SELECTION 

User can select any time interval 
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Click on the calendar icons opens pop-up for selection of the From-To dates for required time interval.  

All snapshots from the selected time interval will be listed grouped by days and ordered by date.  

 

CONSULTATION SELECTION 

 

Selection of basic consultations for the selected snapshot is accessible after right-click in the context menu.  

 

Analyze STATSPACK Analyze AWR 

• TOP SQLs 

• TOP Segments 

• TOP SQLs 

• TOP Segments 

• Top Events 

  

 

 

 

 

Note: For selecting more snapshot (also from different dates) press SHIFT and select rows with left-click. Right-click opens context menu for selection of 

consultations.  
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TOP SQLS 

 

Consultation TOP SQLs shows in tabular form data for following statistics: 

• SQL ordered by Elapsed Time 

• SQL ordered by CPU Time 

• SQL ordered by User I/O Wait Time 

• SQL ordered by Gets 

• SQL ordered by Reads 

• SQL ordered by Physical Reads (UnOptimized) 

• SQL ordered by Executions 

• SQL ordered by Parse Calls 

• SQL ordered by Sharable Memory 

• SQL ordered by Version Count 

• SQL ordered by Cluster Wait Time - available only for RAC environment 

 

Panel TOP SQLs depending on the number of selected instances automatically opens as: 

• Single instance view – for one selected instance  

• RAC view - for more selected instances 

  

 

SINGLE INSTANCE VIEW 
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RAC VIEW 

Panel TOP SQLs RAC view opens when more nodes/instances are selected. 

 

Note: This functionality is available only for AWR Analyzer (not for STATSPACK). 

 

 
 

 

 

SELECTION CRITERIA 

In top section there are selection criteria: 

• Module  

• Rows per table 

and 

• SAVE button 

 

Module –SQLs are filtered by entered text: UPPER(SQL Module) LIKE UPPER(%‘entered text‘%) 
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Note: This criterion is very useful when optimizing processes. When name of online or batch process is entered in the field "Module" system will identify all SQLs 

in this process.  

 

 

 

MAIN PANEL 

 

Main panel displays all statistics in separate tables. 
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SAVING CONSULTATION DATA 

 

In the left top corner there is a button for exporting all tables into EXCEL .xlsx file. 

 

 

Name of file is generated automatically. It contains identification number of the snapshot's interval snap_from and snap_to (1 and 4). It can be altered by user.   

 

Generated EXCEL file has particular SQL statistics stored in separate tabs named by type of statistics. 
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COPY OF DATA INTO CLIPBOARD 

 

Content of the cell, row or whole table can be copied into clipboard by selecting required object and clicking with right mouse button. Menu appears: 

• Copy Cell 

• Copy Row 

• Copy Table 

 

 

 

 

VISUAL CONNECTION OF THE TABLES 

 

While moving mouse pointer over the table, the rows with the same SQL Id are selected automatically in the other sections which allows better intelligibility. 
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SQL DETAILS 

 

After click on any row details of selected SQL displays on the right side. These details are constrained by used level of STATSPACK / AWR. 

 

SQL Details panel consist of these sections: 

• Panel bar 

• SQL text 

• Data for every execution plan (PLAN_HASH_VALUE): 

o SPM panel - only in Analyze AWR 

o execution plan 

o historical information 

o bind variables - variables from runtime 

• Summary for all execution plans 

 

 

PANEL BAR 

 

Panel bar contain: 

• Export of all details into PDF 

• Copy - copy SQL text into clipboard 

• Checkbox for SQL formatting 

 

Export example 

 

sqlDetails_a6ygk0r9

s5xuj_1_4.pdf
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SQL TEXT 

 

SQL Text displays the text of SQLquery either formatted or in original form depending on value of "Format SQL“ checkbox in panel bar.  
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SPM TOOL 

 

AWR Analyzer contains also tools for work with SPM. 

 

Briefly about SPM: 

Performance of any database depends mainly on the execution of the query. Oracle optimizer is not always perfect in selecting the best execution plan without 

user's intervention. Execution plan can change from many reasons including: optimizer statistics regulations, changes of the parameters of optimizer or schemes 

definitions and metadata. Optimizer's  inability to guarantee best execution plan led some users to freeze the SQL execution plans or lock the optimizer statistics.  

But this approach prevent them from using the new features of optimizer which could improve performance of the SQL queries. Ideal solution would be keeping 

actual execution plan during the changes of environment and changes of the plan would be allowed only in case of improvement of the performance. 

SPM provides user with such frame and allows him fully manage SQL execution plans. By using SPM optimizer automatically manage execution plans and 

guarantee to use only verified plans. When new execution plan is found for SQL, it will not be used until is verified by database whether has the same or better 

performance than actual plan. 

 

 

 
 

 

SPM functionality 

 

Plans may be loaded from cursor cache 

 

 

 

 

Or from workload repository 

  

 

 

 

Setting the plan by one click 
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When plan is set - new control buttons and information fields are displayed. These are used to enable plan or to set it's parameters. 

 

 

 

Plan can be removed by clicking on button "Drop this plan" 

 

 

 

 

 

EXECUTION PLAN 

 

In details of SQL query all plans with costs are displayed by hash value in the tree.  

Root of the tree shows PLAN_HASH_VALUE number. 
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BIND VARIABLES 

 

 

 

SQL SUMMARY DATA 
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TOP SEGMENTS 

 

Panel "TOP Segments" is opened from right-click context menu. 

 

 
 

Main panel for  TOP Segments 

 

 
 

 

After some row is selected, DDL of selected object is displayed  in the detail frame on the right side of the screen  

 

It is possible to save DDL as PDF by clicking "Save" button. 

 

segmentDetails_SYS

-I_OBJ5-INDEX.pdf

exported_tables_2_

5.xlsx
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TOP EVENTS 

 

Main panel "TOP Events" with data within the time interval snap_from and snap_to: 

 

Note: Top Events panel doesn't contain detail SQLs. 
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OPEN CURSORS 

 

Functionality of Open Cursors allows user to identify the cause of error  „ORA-01000: maximum open cursors exceeded”. This error is usually solved by increasing 

parameter OPEN_CURSOR without investigating the real cause which can lead to increased consumption of the system resources. 

This error is often caused by keeping cursors opened even if are not used any more (e.g. in JAVA). With OPEN CURSORS feature is possible to identify sessions 

which have most opened cursors.  

 

Open cursors panel is opened from "View"-> "AWR and STATSPACK Monitoring Tools" -> "Open Cursors" menu 

 

 

 

MAIN PANEL 

Panel displays TOP Sessions by number of opened cursors in the graphical form on the logarithmic scale where sessions are displayed in different colors. In the 

graph there is also displayed value of parameter OPEN_CURSOR. Reaching this value will raise the error ORA-01000. The graph legend contains identification 

data like session ID and instance ID. Details about the running SQL queries of the particular session can be displayed by clicking the button of the corresponding 

color.  
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SELECTION CRITERIA 

Top bar provides user with the selection criteria for the database connection (OPEN CURSORS monitoring is real-time online process therefore it is not working 

with the imported AWR/STATSPACK data). 

 

 

Selection criteria allows working with the one (single instance or one instance of RAC) or more nodes of database RAC. 

 

On the left side of the bar there is a combo-box for selection of the type of Cursor Select 

 

On the right side of the bar there are more criteria for Refresh (refresh rate in seconds) with "Pause" button, Sessions Count (number of monitored sessions) and 

Cursor Type(s). 

 

 

Types of Cursors: 

 

 

 

PANEL TOP SESSIONS 

Graph legend example: 
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When the one of the buttons in the graph legend is clicked, bottom section is populated with the list of all running SQL queries within the selected session. 

Queries can be exported and details of the SQL can be displayed after double-click (SQL text is also displayed as a tooltip when the mouse pointer is moved over 

the selected row). 

 

 

 

Detail on double-click: 

 

 

Note: Problematic opened cursors can be detected by monitoring the session with the increasing number of open cursors with the repeating SQL_ID in the 

details. That indicates repetitive opening of the cursor with the same SQL query. Good manner is to export all SQLs of the monitored session and compare 

manually because it is possible that there are more same SQLs with different SQL_ID (or the "Hard Parse" problem when the variables are not sent as parameters 

but are hardcoded in the SQL query).   
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FIND SQL 

 

Tool for finding particular SQL query by various criteria (Module, SQL text, Execution Plan hash value). 

Panel is designed for searching by criteria so non-selective criteria can cause performance problems.  

 

Panel Find SQL is opened from "View" -> "AWR and STATSPACK Monitoring Tools" -> "Find SQL" menu 

 

 

Panel displays basic data about found SQL queries:   

• Number of processed rows 

• Number of executions  

• Elapsed time 

• Average time per execution  

Details of the SQL query are displayed after click on the selected row. SQL text can be formatted and its plans can be uploaded with SPM functionality (described 

above). 
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APPENDIX 

 

EXAMPLES OF EXECUTION PLANS AND THE WAY HOW TO INTERPRET IT 

 

In the Execution Plan are the details of all steps highlighted with different colors and also columns used for RANGE SCAN are highlighted.   

 

Example 1 - in the row with INDEX RANGE SCAN is highlighted only first column which means that range scan used only first column of the index. 

This feature helps user to identify the problems related to the use of the wrong index or the wrong index structure. 

 

 

 

 

Example 2 illustrates how many columns in the index were used: 

 

 

 

Example 3 illustrates which columns were used by INDEX SKIP SCAN  
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